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Welcome to REAL/Easy Custom Reporting 

 
 

An important value of REAL/Easy as a management software tool is its ability to help a company track and manage its unique 

programs.  REAL/Easy does this through a custom reporting module as well as with customization options within many of its 

Standard Reports.  

 

This reference book has several purposes: 

1. To document how to integrate custom written tracking and analytical reports into the BOS reporting system.  

2. To provide basic training for users who wish to write custom reports accessing REAL/Easy databases.  

3. To document how standard reports in BOS and FOS can be customized but still run from REAL/Easy menus.  

4. To document how to write custom reports that can access multiple company databases.  
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When Is Custom Reporting Used? 

First, there is no software system that can provide for all management reporting and information needs of a company. For 

aggressive and creative companies, no matter how many report commands a program has,  there is always the need to 

maintain spreadsheets, documents, manual tallies, or work sheets to analyze and track new and special company programs.  

To meet these needs, managers design their own tracking, follow-up, or productivity worksheets. These are programmed with 

Excel, Word, Publisher,  or within customized database programs.  

Examples might include: 

• Company Annual President Club Awards 

• Top Rookie Agent Tracking 

• Central Listing Marketing Database and Information  

• Office Productivity and Service Index 

• Sales and Agent Account Cash Flow Forecast 

• Agent Trainer Success Report 

• First Year Production Comparison 

• Branch and Agent Production Ratio Analysis 

• Listing and Sales Productivity Trend lines 

• Top Company Metrics Dashboard 

• Income Statement Ratio and Productivity Analysis 

• Agent Account Receivable Collection Trends 

• Vendor Payables Payment Scheduling 

• Agent account statement and production summaries pdf file emailing.  
 

To help, REAL/Easy offers a powerful method to build and integrate special tracking and worksheets: 

1. The ability to customize any report within REAL/Easy. This is where a standard report provides “90% of what I need” and 

the report is modified to provide 100%. All standard reports are written using the Crystal Reports
®
 language.  

2.  The Custom Reporting module. Reports can be built from scratch using Crystal Reports, or, from a similar existing 

BOS/FOS report, using Crystal Reports and then integrating them into the BOS module.  This reference will cover the use of 

this method.  

 

 

With Custom Reporting, each BOS user can run the reports from an easy to use menu. The user control features within BOS 

enables secured distribution to others in the company. This means that some custom reports can accessed by branch managers 

and staff while others may only be accessed by owners or company level staff. Further, the system can restrict a branch 

manager to only viewing information from their branch.  
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Custom reports can be written for any customer by the REAL/Easy support staff. This is a special service and charges are 

based on the time taken. Over the past several years the staff has built or modified over 2000 reports for customers in North 

America. 

 

Custom reports can be written by you. Many customers own a copy of Crystal Reports. When you have your own license, you 

can program your own reports with the help of this guide and place them within BOS’s custom reports module. This reference 

book helps by showing you how the REAL/Easy database is designed, how to program basic reports, and how to place reports 

onto the Custom Reports menu. Training books, CBTs, and DVDs, and classroom training are available nationally for Crystal 

Reports – the most popular reporting language worldwide – so it’s convenient for staff members expand their skills to include 

this valuable capability.  

 

 

As mentioned above, a valuable feature of REAL/Easy is that all of the standard reports included in BOS and FOS are written 

with the reporting system Crystal Reports
®
. If report format or content changes are needed, the staff at REAL/Easy can do 

these and install them within the customer’s BOS and FOS systems.  

This also means that any customer owning a license to Crystal Reports has the ability to modify the reports to help increase 

their value.  
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Running Custom Reports 

 
The Custom Reports module is accessed from REAL/Easy BOS’s Reporting section. Both company level users (users that can 

see data from all offices) and office level users can use custom reports.  

 

 
When the “Run Custom Programs or Reports” is clicked, the operator is shown a menu of available reports. The operator can 

run any report on the list. The list is built based on the user’s level – either company or branch level - and the report access 

level assigned to the user.  

The above report menu is typical for a company level user. Each report has a name and a level fro 1 through 9. The report 

may or may not be assigned for a certain office’s use – this is optional. For this user, two office level and one company level 

reports are available.  

To run a report, choose the report and then click the “Run” button.  
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A custom menu for an office level user is shown above. Only “Office” level reports are available. Note that in REAL/Easy, 

company, office, and agent level users can be assigned.  

 

 
 

When a custom report is run, a “Parameter” window will appear. This enables the operator to make data selections for the 

report. A value must be set for each parameter by choosing/highlighting the parameter on the top list and entering its value in 

the center of the window.  

Most parameters will be for dates. Other parameters can enable the operator to select listing or sales status’, which offices to 

include, and how to sort (order) the report (e.g. list by price or date order).  
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Above is an example office level report produced for a user assigned to OFFICE1. Custom reports can be setup to only 

display data from the user or manager’s office.  
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Below is an example company level report written to show an owner, setup as a BOS company level user, the production 

figures from all of the branches:  
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If your company offers the REAL/Easy Agent Office System, AOS, custom reports can be offered to your agents.  

 

 
 

Custom reports are accessed in AOS by clicking the “Custom Reports” tab on the AOS desktop. When an agent logs into 

AOS, the system knows the agent ID of the users.  

 

 
 

This ID is used by each custom report to display only information for the agent user.  
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Setting Up Custom Reports 

Custom reports are written to list, summarize, analyze data at all levels: companywide, office/branch, and agent. All users 

who have access to BOS can also be given controlled access to the custom reports in the same manner the system controls 

access to all of BOS and FOS standard build-in reports.  

 

Setting Up User Access 
 

 

 
A first step to controlling reporting access is taken within the “Setup Users” command.  

 

 
 

User names are maintained from the setup users list screen.  
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Users are designated as Company or Office or Agent level. Above is an example of a company level user.  

 

Each user is also assigned an access level for General and Report commands. The Report level can be set from 1 through 9.  

A user with a reporting level 9 can only access reports that have been assigned a level of 9.  A user with a reporting level of 1 

can access reports assigned to level 1 and up, or all levels.  

 

If a user is assigned to a reports level of 5, this user could access all reports set to levels 5 through 9 but not reports assigned 

to levels 1 through 4.  

 

 
Above is a sample office user setup. The user will be able to report on office2 data only. Further, the reporting access level is 

set to 4. This means that reports requiring access levels from 4 through 9 will be available. Reports assigned to levels 1 

through 3 would not be available.  
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Setting Up The Report Access 
 

 

 
 

Custom reports should be saved within the \Reports folder within the BOS/FOS installation.  If REAL/Easy is installed on a 

server, the reports would be save there also within the server’s  \BOS\Reports folder.  

 

 

 
Users run custom reports using the “Run” button as shown above within the Custom Reports module. System administrators 

will setup the custom reports menus using the “Add/Edit” button.  

 

 
The custom reports list example above has three reports. Two of them are Office level reports and the third is a Company 

level report. Each office level report has been written and assigned to a particular branch (OFFICE1 for the first report and 

OFFICE2 for the second report).  
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Each custom report is setup with the above screen. First, the menu or report name is entered. Next the report name is entered 

using the reports\ folder path. The custom report name above was “branchofficeboardquartile.rpt”.  

The user level required for access is entered – Company level reports can only be run by company level users. Office level 

reports can be run by company or office level users.  

If the report is to be limited to a particular office level user, that office can be assigned in the “For this Office or All”.  In this 

example of a company level report, this would be set to “<ALL Offices>”. 

The user minimum access level required is assigned. In the above example, the report is assigned a minimum level of 1. This 

means that only users with a level 1 assigned can run the report. Users who are assigned a level of 2, 3 up to 9 would not be 

able to run this report.  

The report status should be set to “Active”. If a report is to be temporarily pulled from use the Status can be set to “Not 

Available” so it does not appear on any run menus.  

The report orientation should also be set. This helps the preview and print program.  

 

 

A special option for customers who own their own Crystal Reports program and want that program to run the report can check 

the special “Run Report With Our Crystal” option. When this is checked, the BOS program will not run the report. Instead, 

the user’s Crystal Reports program will be used to run the report.  

This can be handy for certain reports where the user might want to do special “ad hoc” selections or modifications. 

This option should also be used to allow access to Crystal Reports that have been written with versions higher than Crystal 

8.5.  
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Above is a sample entry for an office level report that would be limited to OFFICE1 users only with minimum reporting 

access level of 2.  

A user assigned to OFFICE2 would not be able to run this report. And an OFFICE1 user assigned a minimum level of 3, 4, up 

to 9 would not be able to run the report as a minimum level of 2 is required.  
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Setting Up Office Level Reports 
 

Many companies create custom reports for their branch managers and administrators. For a multi-office company, the report 

is to list data only from the user’s office. When building an office level report, the program is directed to select data from a 

single office.  

A selection statement might look like this in a report written to list active agents for a branch:  

 

 
The report would select agents from OFFICE1. 

If a company had many branches, using this method, a different report would have to be written and assigned to each branch.  

To enable writing of only office level report that would select data from the user’s office, a special formula field can be used 

in the report: {@UserOfficeID} 

 

 
This shows how this formula field would be used in the selection instead of assigning only one office ID. Below is an example 

of using this special formula field in a report: 

 

 
This is a report that lists active agents from an office. The agent name, address, office ID, status and type are listed. We want 

this report to run the agent list only for the user’s office. If the user is from OFFICE18, the report is to list agents only from 

OFFICE18. If the user is from OFFICE2, then only list agents assigned to OFFICE2.  
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The special formula field is added to the report using the crystal commands Insert � Field Object 

 

 

  
Next add a formula field named “UserOfficeID” to the “Formula Fields” list.  

 

 
Using the report “Selection Formula” tool, insert a statement that will select agents only from the UserOfficeID:  

 

 
The select statement would appear as above. 
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The report would be setup in the custom reports menu as shown above. Key setups are: 

• User Level is set to “Office”. The report will be available to the office/branch level user. 

• For this Office of All is set to “<ALL Offices>” 

• Minimum Level Required: assign this value as per your user setups discussed on previous pages.  

 

When the report is run by a user, the BOS system will assign their office ID to the special formula field UserOfficeID for you.  
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Running the Office Level Report 
 

 
An OFFICE2 user login is shown above. The BOS system knows that the user is Office level and assigned to OFFICE2.  

 

 
Above, the user’s menu displays the “agent list” report. When the user runs the report, BOS assigns their login office ID to the 

special formula field.  

 

 
The automatically selects only OFFICE2 agents since that is the office ID assigned to the special formula field.  
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Setting Up Agent Level Reports  
 

Custom reports can also be setup for your agents to access within the Agent Office System (AOS). Each report must be setup 

so that only the AOS user’s data will be reported and not the data from other agents. Note, that the staff at REAL/Easy is 

available to build and install agent level custom reports also.  

 

When custom reports are written for AOS / agent level access, it is important to insure that the report will only display 

production or information for the agent that is logged into AOS and not data from other agents. When the agent level user is 

created, that agent-user must be assigned to an agent ID from the in-house agent roster. Each agent is assigned a unique agent 

code.  

 

When REAL/Easy runs an agent level custom report, it will tell the report the agent ID code of the agent-user. To obtain and 

select data only for that ID code the custom report author must do these two steps: 

 

1. Create a report  “Formula Field” named  “UserAgentID”.  The value of this field is assigned by AOS when the report is 

run. 

2. Include in the record selection statement that the agent code for all report data is to be equal to the “UserAgentID”.  

 

 
Above, example of inclusion of the formula field “UserAgentID”.  

 

 
 

Above, example inclusion in the selection expert (expression) of the agent code field must be equal to the formula field 

“UserAgentID”.  
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Building Custom Reports Course 

 
 

Welcome to the Building Custom Reports Course for customers using the REAL/Easy BOS® or the REAL/Easy Database.  

 

• In this course you will learn how to create and modify management reports that can help you track and analyze your 

company’s performance. 

• The program used to create the reports is called Crystal Reports. It is a popular report writing program that can be 

used create custom production reports for your company.  

• Because the BOS system also uses Crystal Report programs for its standard reports, BOS users will also learn how to 

modify these as well. 

• For customers using the REAL/Easy database you will learn best practices for developing your own reports. 

 

REAL/Easy BOS is the system used to maintain the agent, listing and sales information  

 

• We will learn to write reports that access BOS data for three areas:  

o agent rosters,  

o listing production,  

o and sales production 

• We will learn how to use Crystal Reports to modify and build reports in the above 3 areas accessing data maintained 

by BOS. Report names are: 

o branchagentrosterbyName.rpt 

o branchranklistwrittenbyunits.rpt 

o branchranksaleswrittenbyAGCI.rpt 
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Learning report building “terms”. 
 

 
 

Accessing Agent data. All reports are built to access certain data from the BOS database. Here is a typical agent roster report 

and it is displaying agent information.  

• Most reports select data from the database. In this case, the roster is only to include agents who are “Active”. This is 

illustrated with the “Status” column.  

• Select: The report is only to include records from the database that are Agents. In BOS, the database contains 

information for either Agents or Employees. So for the agent roster, the record type of “AGENT” is selected as 

illustrated with the “A/E” column. 

• Further, reports also sort, or order, the data in some way. Above, the records are sorted by the agent’s last name. 

• The sample Crystal report name is: branchagentrosterbyname.rpt  

 

 
Accessing Listing Data. Above is a sample listing production ranking report. The listing database in BOS contains 

information for all listings no matter when they were written or what their status. 

• The report above makes two key selections, what are they? 

1._________________ 

2._________________ 

• Further, the report is sorted a certain way, what is it? _______________ 

• When learning about how to create listing production reports from BOS, you will learn that some items on the report are 

obtained directly from data stored in the BOS database. Listing units, for example, is stored in the database.  

• Other items you want may need to be calculated from fields stored in the database. An example of this is the agent’s 

“Volume” figure - it is calculated from other items stored in the BOS database. 

• The Crystal report name is: branchlistwrittenbyunits.rpt 
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Accessing Sales Data:  Above is a sales production ranking report. Many figures are included from GGI down to Company 

Dollar as well as units and volume awarded.  

• What are the two key selections made by this report? 

______________________ 

______________________ 

• How is the report sorted? ___________________________ 

• When building sales production reports from BOS data, you will learn that some of the financial and award data is stored 

in the BOS database and others need to be calculated. For example, the Agent Gross (earnings) is stored in the database 

but Company Dollar is calculated. This will be covered in detail later. 

• The Crystal report name is: branchranksaleswrittenbyAGCI.rpt 

 

About Key BOS/FOS Tables 
 

 
 

• Databases are used by BOS to store groups of related information. 

• Each database consists of a number of Tables - e.g. an “agent” table is in each database for storing agent names and 

other agent information 

• Reports are written utilize a certain table or tables - e.g. to write an agent roster by name report we would use the 

agent table 
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• Tables are made up of records of pieces of information called fields - e.g. in the agent table, fields might be name, 

address, phone number. For each agent entered into an agent table there is a record in that table. If you have entered 

25 agents that means you have 25 records in the agent table. 

• When you print, select, and sort data, you are really doing this with the fields that are within records that makeup the 

tables. 
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There are a number of BOS/ databases. Of all of these, there are four key databases. We will learn about their content and 

how to build reports that access their tables and fields. 

• The AGENTS database mainly contains the agent and employee information entered in BOS. 

• The COMMON database has many tables. Most are setup, or Preference, tables such as the offices and property 

types. 

• The FRONTOFFICE database also has many tables. The key tables we will deal with are those containing the 

listing information. 

• The BACKOFFICE database is the largest in the BOS system. Here transaction information is maintained. 

 

 
 

The key tables within each database is listed above. While each database has many more tables than we list here, we are 

concerned with the above tables for production reporting. 

For AGENTS, we note only the AGENTS (same name) table. It contains agent and employee information that is entered in 

the BOS Setup module. 

For the COMMON we note seven tables: 

1. OFFICES contains the office codes and names entered in BOS Setup and assigned to agents, listings, and 

transactions... 

2. PROJECTS contains the project codes and descriptions entered in BOS Setup. 

3. PROPERTYTYPE contains the property type codes assigned by BOS and the user descriptions entered in BOS 

Preferences and assigned to transactions. 

4. FINANCEYTYPE contains the financing type codes assigned by BOS and the user descriptions entered in BOS 

Preferences and assigned to transactions 

5. BUYERSOURCE contains the source ID code assigned by BOS and the descriptions you entered in BOS 

Preferences and assigned to transactions. 

6. SELLERSOURCE contains the source ID code assigned by BOS and the descriptions you entered in BOS 

Preferences and assigned to transactions. 

7. SOURCE OF BUSINESS is the source descriptions entered in BOS Preferences and assigned to seller and buyer 

contacts. 
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For the FRONTOFFICE database, we will work with these tables: 

• LISTINGS contains address, price, and other key information for each listing you enter in BOS Listings module. 

• LISTINGAGENTS has a many-to-one relationship with LISTINGS and contains one record for each listing agent of a 

listing. 

• LISTINGCONTACTS has a many-to-one relationship with LISTINGS and contains one record for each seller name for a 

listing. 

For the BACKOFFICE database, we will work with these tables: 

• TRADE contains address, price, and other key information for each sale you enter in BOS Transactions module. 

• COMMISSIONS has a many-to-one relationship with TRADE and contains one record for each commission payee for a 

transaction. 

• TRADECONTACT has a many-to-one relationship with TRADE and contains one record for each seller name, buyer 

name and other contact name for a transaction. 

 

Agents Database, Agents Table 
 

 
 

Users of BOS are familiar with the agent information screen above left. At the right side is the field layout of the Agents 

database’s Agent table. Most of the fields are named so that you can easily ascertain their contents. Tables generally contain 

numeric, alphabetical (or alphanumeric), dollar, and date field types. Some of the fields are needed to identify the records and 

others contain formation relating to the record. 

 

In naming the table fields, the BOS authors used prefixes to indicate the field type. “sz” is used to indicate an alphabetical or 

“string” field, the “dt” prefix for “date” fields, “d” prefix for “dollar and cent” or “decimal” fields, and “I” for integer 

(number) fields.  

 

We note these key fields within the Agents table (arrows above): 

• The agent code, szAgentCode, is a unique id that you assign to each agent. It is alphanumeric. 

• The agent report name, szName 

• The agent’s start date, dtStart 

• If terminated, the agent’s termination date, dtTermination 

• The agent’s office, iOfficeID (is alphanumeric, e.g. “OFFICE1”) 
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• The agent status, szStatus (ACTIVE or TERMINATED) 

• The Agent table record type, szType (AGENT or EMPLOYEE) 

• The last name, szLastName 

• The first name, szFirstName 

• The display name used for lookup tables, szDisplayName 

• The full or part time indication, szFullPartTime 
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FRONTOFFICE Database, Listings Table 
 

 
 

For each listing entered in BOS there is a LISTINGS table record. The key entry screen for the BOS listing information is 

shown above. Key fields are shown to the right include: 

 

• the FOS list number, used to identify the listing, is szListingID 

• the Office assigned to the listing is szOfficeCode (e.g. “OFFICE2”) 

• the MLS number is stored in field szMLS1. (there is also a second MLS number). 

• The listing’s status is within szStatus (e.g. “Active”, “Pending”, “Sold” ) 

• current list price: szCurrentListPrice 

• listing taken date: dtListDate 

• list of list side agents: szAgents 

• the listing property type: szPropertyType (e.g. “Residential”) 

• source of the seller: szSellerSource 

• an important BOS system assigned field, iListingIndex, is used by BOS to uniquely identify the listing records. This field 

is important as it is used to “join” to other tables with listing information. 

 

 



Building Custom Reports Course  

Page -30  FRONTOFFICE Database, Listings Table  REAL/Easy Custom Reporting 

FRONTOFFICE Database, ListingAgents Table 
 

 
 

• For each listing agent entered for a listing there is a record stored in the ListingAgents table. There would be two records 

in this table on a split listing where each agent has 1/2 of the listing.  

• As illustrated above, the agents are entered using the “Agents” tab of the listing entry windows.  

• The unique identifier that ties the records in this table to the Listings table is the iListingIndex field. 

• The agent ID code: szAgentCode (this is the same as the AGENTS table szAgentCode field). 

• The list side units: dListUnits 

• for convenience for report writers, many fields from the AGENTS table are copied into the ListingAgents table. These 

include the agent report name, szDisplayName.  
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FRONTOFFICE Database ListingContacts Table 
 

 
 

Seller names and other contacts for each listing are stored in the ListingContacts table within the FrontOffice database. For 

each seller entered on the listing entry screen’s “Contacts” tab, there is a ListingContacts record. 

 

Key fields include: 

• iListingIndex is the field that links this table to the Listings table. 

• The contact type, e.g. “Seller”, is stored in the szContactType field. 

• The source of the contact is stored in the szSourceOfBusiness field. 

• If you are assigning the contacts to agents, the agent’s ID code is stored in the szAgentCodeSource field. 

• If assigning contacts to offices, the Office ID code is stored in the szOfficeCode field. 
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BACKOFFICE Database, TRADE Table 
 

 
 

• For each BOS transaction, a record is stored within the BACKOFFICE database’s TRADE table.  

• BOS entry screens are shown above with most key information entered on the “Property” tab. This includes the property 

address, transaction ID, sale price, status, and important dates. 

• The “Demographics” tab is used for sources and financing and the custom fields.  

• And the “Other Selling Broker Listing Broker” tab is used to enter co-op broker details. 
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The TRADE record is quite lengthy. The key fields are indicated above with red arrows.  

 

• iTransactionID is the system assigned numeric transaction ID or BOS ID. This is a unique number used by the BOS 

system to identify each TRADE record and to link to other tables having other transaction information - e.g. 

COMMISSIONS and TRADECONTACT. 

• iOfficeID, though not used for production reports, is the main office ID (e.g. OFFICE2). 

• iProjectID is the project (if any) assigned to the transaction. This is a numeric code assigned when the data entry user 

selects the project description from the PROJECTS table. 

• iTransactionStatusID, is a code that indicates the transaction’s status. (“3”=closed, “4”=pending, “5”=cancelled, 

“2”=firm, “6”=backup offer). 

• dtPending: the transaction pending date (also called “open”, “Sale” or “offer accepted” date). 

• dtClosing: the transaction close date 

• iSellerSourceID, is the seller source assigned to the transaction. This is a numeric code assigned when the data entry user 

selects the seller source description from the Seller Source table. 

• iBuyerSourceID, is the buyer source assigned to the transaction. This is a numeric code assigned when data entry selects 

the buyer source description from the Buyer Source table. 

• iFinanceTypeID, is the financing method assigned to the transaction. This is a numeric code assigned when data entry 

selects the financing description from the FINANCETYPE table. 

• szTranType: the transaction type (“FL-FS”, “FL-CS”, “CL-FS”) 

• szRealEasyID: an alternate transaction ID and, if converted from REAL/Easy, that tran ID.  
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BACKOFFICE Database, Commissions Table 
 

 
 

The key table used for sales production reporting is the Commissions table. For every row entered within the transaction entry 

“Commissions” tab, there is a Commission table record. This includes all green (income) and white (fees and commission 

expenses).  

Shown above is a sample agent commission entry screen. It has two tabs: the “Commission Worksheet” and the “Allocated 

Gross For Commission Plans”. Some of the key fields used for reporting are indicated with the red arrows in the above record 

field layout:  

 

• iCommissionID is a unique BOS system ID assigned to each record 

• iTypeID is a numeric code that indicates the record type (e.g. 35 = and agent commission record). All id types are listed 

later. 

• iTransactionID is the numeric BOS transaction ID that ties the Commission table records to the TRADE records.  

• dListComm: the agent gross list side earnings 

• dSellComm: the agent gross sell side earnings 

• szRoleID is a string field that defines the role selected for the income or commission in the record (e.g. “list side” or 

“Office GCI” or “Referral”). 

• dListUnits: the list units (sides, legs) awarded to the agent. 

• dSellUnits: the sell units (sides, legs) awarded to the agent. 

• dListVolume: list side volume awarded to the agent. 

• dSellVolume: sell side volume awarded to the agent. 
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BACKOFFICE Database, TradeContact Table 
 

 
 

Sellers and Buyers, title and mortgage companies, and other contacts important to track for each transaction are entered within 

the transaction screen “Contacts” tab. For each contact, a record is stored in the TradeContact table.  

 

• iTransactionID is the numeric BOS assigned transaction code tying each TradeContact record to the TRADE record.  

• szContactType stores the contact type, e.g. “Seller”, “Buyer”, “Title Company”. 

• szSourceofBusiness stores the source of the contact. This is string field and the value is selected by the data entry person 

from the SOURCEOFBUSINESS table setup in Preferences. 

• If assigning agents to contacts, the Agent’s ID is stored in the szAgentCodeSource field. 

• And, if assigning contacts to an office, the office id is in the szOfficeCode field (note Office names are in the Offices 

table of the Common database 
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How to Modify Agent Roster Reports 
 

 
 

Modifying Reports: The agent roster reports access the Agents database Agents table. In the next few pages we will walk 

through using Crystal Reports for agent rosters or lists. However, the Agents table can also assist with production reporting. 

• The key production tables are the FRONTOFFICE database’s LISTINGAGENTS table and the BACKOFFICE 

database’s COMMISSIONS table.  

• Often, reports will need to access the production tables and the Agents table for selections and sorting.  

• For example, if you wish to have a production report for only agents who are active, that you need to join the Agent table 

to the production table so the selection can be made on the Agent table’s szStatus field.  

• Or you may want to run a production report on newly hired agents. Again, the Agent table would be joined to the 

production table so that the selection expert would select on the Agent.dtStart field.  

• Further, if you want any report to sort on the agent last name, you would again join to the Agent table and with the sort 

expert sort the szLastName field.  
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Agent Roster: Crystal Reports Designer 
 

 
 

• The Crystal Reports Designer is used to modify and build reports that access the BOS data. The general appearance 

of a report within the designer is illustrated above with an agent roster report named: branchagentrosterbyName. The 

report name is in the title bar. 

• Tools include the “selection expert” (hand) to setup record selection criteria (e.g. szStatus = “Active” agents) and the 

“sort expert” (A->Z) to define how to sort the records (e.g. szLastName). 

• The report is divided into sections or groups starting with the Report Header. Here, the various report text headings 

and fields are placed to create the report. All reports have at least a report header and footer and a “Details” section. 
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Agent Roster: Database Visual Linking 
 

 

 

Agent Roster: Use Preview 
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Agent Roster: Select and Sort Experts 
 

 

 

Report Options Recommendation 
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Agent Roster: Sections and Fields 
 

 
 

• In the report above, the report title and column headings are placed in the “Page Header” group.  

• The agent names, ID’s, start dates, etc. are setup for the report within the details section. For each Agent record 

selected, a details line is printed. This line can be modified in any way by deleting, adding or moving fields.  

• As illustrated above, database-table (e.g. Agent) fields are added with the menu command “Insert” -> “Field Object” 

-> “Database Fields”. 

• Note that besides Database fields other field objects are:  

• formula fields - fields you build that are calculations 

• parameter fields - fields that you create to prompt for selections (e.g. office ID) 

• special fields - fields you can also use on the report (e.g. “Page N of M”) 

•  Text is added to the report (e.g. column headings) with the menu command “Insert” -> “Text Object” 

 



Building Custom Reports Course  

REAL/Easy Custom Reporting  How to Modify Listing Production Reports  Page - 41  

How to Modify Listing Production Reports 
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Listing Production Reports – Typical “Join” 
 

 
 

• The tables are normally joined as shown above using the iListingIndex field from both tables. This can be checked, or 

changed, using the Database -> Visual Linking Expert. 

• If data from the Agents.Agents table is needed, then join that table’s szAgentCode to the ListingAgents table’s 

szAgentCode field. 

 

 

 
 

• In addition to having database fields placed in the report, calculations using formula fields are utilized also. An example 

of a formula field is the “@calclistvolume” field.  

• Formula fields are created from the Insert command -> Field Option then to the -> Formula fields group. 

 

Listing Production: Top N/Sort Expert… 
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Another key feature in Crystal Designer is the ability to rank subtotals.  

• Question:  How are the agent totals sorted by the total units for example and not the agent’s code?   

• Answer:  To setup sorting by ranking, use the menu command Reports -> “Top N/Sort Group Expert…”. Here you can 

rank (sort) by any field that is subtotaled for the group (e.g. units or volume in ascending or descending order). 

 

 
 

• Crystal Reports Designer is to modify and build listing production reports. The above report, 

branchranklistwrittenbyunits, is a typical ranking report.  

• Note that the Details section applies to each ListingAgents record. These records are not printed in the report as you can 

observe by the section being darkened (grey).  

• The Group #2 totals all records by agent (ListingAgents.szAgentCode) and this level is printed - white color for this 

section.  The detail records are actually subtotaled to obtain each agent’s total listing and volume production.  (Groups, 

or Subtotal levels, are added using the menu command Insert ->  Group…) 
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So why is the Listings table included?      There are a couple of reasons: 

1. The production report is for a certain office and listing date range - so the Listings.szOfficeCode and  Listings.dtListing 

field is needed by the select expert.  

2. The property address was desired for the Details section. Note that the Details section is not printed in the report but you 

can enhance your reports by allowing the “drill-down” feature for the section. This means that a user can click on a report 

preview of a Group #2 agent record in this case, and then observe all properties that made up the production total. 
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How to Modify Sales Production Reports 
 

 
 

A typical sales production ranking report is shown above. Key production figures include: 

• GCI: Gross Commission Income 

• AGCI: Adjusted GCI - the amount of income received by the company after referrals are paid. 

• Off-Top/Franchise: the fees paid to franchises and/or allocated to costs of doing business 

• NAGCI: Net AGCI = AGCI less Off-Top 

• Agent Gross: the agent gross earnings 

• Company Dollar: NAGCI less Agent Gross 

• Agent Net: net agent commission after transaction fees 

• Trans Net: Company Dollar plus agent transaction fees 

• Units: awarded units (sides, legs) 

• Volume: awarded volume 

 



Building Custom Reports Course  

Page -46  How to Modify Sales Production Reports  REAL/Easy Custom Reporting 

 

 
 

Sales production reports access and compute totals of fields in the COMMISSIONS table. This table is joined to the TRADE 

table for property, date and status information. 

 

Sales Production Reports: Typical “Join” 
 

 
 

• Production reports are setup joining the Commissions and Trade tables using the iTransactionID field from each. 

Depending on the report selections, joining in one direction may be faster than the other. Test the reports to 

determine which way is better.  

 

• It appears that if the report is selecting data for a selected agent or office in a large multi-office company, the above 

direction Commissions to Trade is best. If a companywide report is selecting a short production time (dates are in the 

Trade table) then joining from Trade to Commissions may be faster. 
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The sample report branchranksaleswrittenbyAGCI is shown above loaded into the Crystal Reports Designer. The page 

headers contain the title and column header information.  

• The details section is hidden from printing and has the property address and statistics from each Commissions record.  

• The Group #2 subtotals by agent. This section is printed and the allocated income and commission are totaled and then 

ranked with the Top N/Sort expert.  

• The key production calculated fields are included in this report. Many customers use this report as the basis for others so 

that the calculations can easily be used without having to re-define them. 
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Sales Production Reports : Tips 
 

 
 

• A key field in the Trade table is the transaction status. This field is a code field and the above defines the meaning of 

the codes 2 through 6.  

• For reports that report the status of each transaction, you should create a formula field that displays a meaningful 

description for each code. 

• A formula field @statusdescription is included in the report file. The expression to assign the description is shown in 

the box above having the “If” and “else” statements.  
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• This illustration defines how all of the production figures are calculated from the Commissions table fields.  

• Shown are the two agent commission entry screens and surrounding are the field names that are used to store the 

entered items.  

• Also defined are various calculations where both sides are combined for totals and how company dollar is calculated.  

• Note that for GCI, AGCI, NAGCI and Company Dollar, the entries made on the “Allocated Gross” tab are very 

important.  

 



Building Custom Reports Course  

REAL/Easy Custom Reporting  How to Build New Reports  Page - 51  

How to Build New Reports 
 

 
 

• So far we have covered how to modify existing reports. When you want to build a new report, there is the option of 

copying an existing report and modifying it. If the new report is similar or accesses the same tables, this can save 

time. However, other times it may be easier to start a new report from scratch. The following pages step through how 

to do this.  

• Use the Crystal Reports, File -> New command and use the Report Expert. 

• The Database button is used first. 
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How to Build New Reports – New Name 
 

 
 

Crystal Reports will then create your basic report and display a preview and shown above with the two tabs. 

 

First, use File->Save-As to establish a report name. 
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Report Options Recommendation 
 

 
 

A key setting recommended for each report is the File menu -> Report Options… screen: set “Convert Date-Time Field” to 

“To Date”,  and uncheck the checkbox for “Save Data With Report”.   

 

Click OK to save and continue with building the report. 
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Accessing Multiple Company Databases 

 
 

Many customers maintain multiple REAL/Easy company databases. Examples are: 

 

• A family of companies that are separate corporations with different owners.  

• Related companies who have merged where databases are the old separate companies and new merged corporation. 

• Multiple periods of the same company including the present company,  and the company up to years 2004, 2000, 

1996.   

Each company has its own set of REAL/Easy databases as shown above. The database locations would normally be folders 

under the main “\BOS” folder such as: 

• Company #1:  D:\apps\BOS\BestRealty 

• Company #2: D:\apps\BOS\Best2 

• Company #3: D:\apps\BOS\Best3 

 

Or, the actual company databases can be in any folder path and not under the “\BOS” folder.  

 

This section outlines methods where custom reports can be programmed to access data from multiple companies for one 

report.  
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Method 1: Using Sub Reports 
 

 
 

One method of reporting on multiple companies is to build Crystal Report consisting of a main report containing subreports.  

The subreports would: 

• Access one of the company databases.  

• Produce a detail and/or summary report. 

• Assign totals to shared variable(s). 

 

The main report would compute grand totals from the individual subreport shared totals.  

 

 
 

The key to this method is the inclusion of shared variables in the main and sub reports.  For example, a main report could 

have variable “GrandTotalGCI” that would sum shared totals from three different company sub-reports: 
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The variable GrandTotalGCI would sum the shared variable values computed by each sub report.   

 

 
The two parameter fields for the close date range are also setup in the main report.  

 

 
A good practice is to set all values to zero in the report header as shown above.  

 

 
The grand total is calculated as shown above. In the calculation, all of the shared formulas (1,2,3) that are computed in each 

subreport are summed and printed in the main report “Report Footer”.  

 

When building the main and sub reports, the database needs to be located. Do not use the “ODBC” connection. Instead use 

the “Database Files” option.  

 



Accessing Multiple Company Databases  

REAL/Easy Custom Reporting  Method 1: Using Sub Reports  Page - 59  

 
The main report and each sub report is setup to point to a different database.  

 

 
Above, illustrates using “Find Database” to locate and connect the main and subreport to a company database. In this example 

the report is to total closed GCI and that data is within the Backoffice database.  

 

 
View/check the database location using “Set Location”.  
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Above, illustration of a location set within a subreport.  

 

 
Above, a sample subreport. This subreport reads the Trade table in this example and computes a GCI total from field 

Trade.dGC within the Report Footer section.  

 

 
The subreport has a formula field and two parameter fields. The formula field is a shared formula that is assigned to the total 

GCI for the particular company. The two parameter fields are date fields used to select the transactions by a close date range.  
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Above – sample of the shared total from company #3’s subreport.  The formula is placed in the sub report “Report Footer”.  

 

 
Above: selection formula for a subreport. Closed status transactions are selected from a specified closed date range. The close 

date range values have been assigned to two parameter fields in the sub report by the main report.  

 

The Main and Sub Reports are connected using “sub report links”  

 
Above, shows the location of the “Change Subreport Links..” option.  
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In this example, the subreport links are used to assign the close date range in the main report to the same parameter fields that 

have been included a subreports.  These links must be setup for each subreport. 
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Method 2: Using Joined Tables 
 

 

 

 
This method of creating a report that combines data from multiple company databases is to build a Crystal Report that joins 

the company tables into one report.  

 

With this method a “root” database table is selected, perhaps from one of the company databases or from a custom built MS 

Access database. This root table is used to join the needed tables from each company database.  

 

 
 

Above illustrates a GCI report having production totals from separate companies with a grand total. The key to this method is 

having each company’s figures computed and printed by a report group level. The other key is using a root table that can be 

joined to each of the company tables to be summed.  
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This example shows how a table, Common.TRANSACTIONSTATUS, from any of the databases, is used to join to the Trade 

tables from three different company databases. In the example the “Trade” database from three different company databases 

are joined to the root table.  

As the trade tables are added to the report, because the table name is the same, the second and subsequent must be joined 

using an “alias” name. The alias name assigned here are “Trade_2” and “Trade_3”.  

 

 
The Link option that must be used is shown above – “Look up all of one, then all of others”.  This means that the records from 

each company Trade table are read separately making it possible for the report formulas to identify and compute the GCI by 

company. 
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Above is a sample report format where multiple company database tables have been joined. A formula 

“CalcCompanyNumber” is used to identify which company the detailed figures come from. This same formula is also setup as 

a report “Group” so that the subtotals can be produced by company.  

 

The “Details” section contains formula fields computed from the joined tables. The GCI formula field is “CalcGCI”.  Another 

formula field is “CalcCompanyName”. This field is also displayed in the group footer to identify each company total. 

 

 
The first formula field needed, “CalcCompanyNumber”, is programmed as above. Because only one of the Trade tables are 

read at any one time, the formula logic assigns the company number based on which table’s transaction ID has a value. Note, 

this field is used multiple times: for the report grouping by company;  in other formula fields; and in the report selection 

expert (the data selection formula).  

 

 
The CalcGCI field is setup as above. It uses the CalcCompanyNumber value to assign the GCI from the right database table.  

 

 
Above, formula for the CalcCompanyName also uses the CalcCompanyNumber to assign the appropriate company name.  
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The above formula, CalcTranID, is not really used in the report but is included to illustrate how to assign detailed values in 

the case where a detailed report is to be built, or what can be displayed in a drill down.  

 

 
Besides the four formula fields used in this report, two parameter fields are also defined for the close date range specification. 

These fields are included in the report title and, when the report is started, are assigned by the operator on the report 

parameters window.  

 

 
The report selection expert/formula is setup as shown above for the report. The root table’s “szTransactionStatusID” is used 

to specify that only closed sales are to be included. Then, because this field is also used to join to the company Trade tables, 

means that only closed sales, Trade.iTransactionID = “3”, will be selected.  

Next, the selection formula specifies the close dates to be included using the report parameter fields and the particular 

company (number) the record is from.  
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How to Setup Custom Reports to be Emailed by PDFeXPLODE 

With REAL/Easy version 14.12 the ability to email reports and billing invoices to agents was introduced.  This section shows 

how custom reports can also be setup to be emailed.  

 

 
The billing invoice printing programs as well as a number of agent level production, commission, and expense ledgers can be 

emailed to agents using the third party program PDFeXPLODE.  

 

 
Reports are run the same manner as usual except that the printer name “PDFeXPLODE” is selected rather than the normal 

laser printer. This special printer will email the pages pertaining to each agent as a pdf attachment.  

 

The details for installing and setting up the PDFeXPLODE program are documented in the version 14.12 upgrade training 

reference. Following here are some of these details and how a custom report can be enhanced so it can be emailed. Further, 

email addresses must be entered in your agent records. Details for this is fully documented in the 14.12 upgrade training book. 
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Variable Settings in PDFeXPLODE and in the Crystal Reports Formulas 
 

Variable Settings – a number of “Variables” are assigned by REAL/Easy when the invoices or reports are run that are used 

to define the pdf folder and attached file names as well as email subject and other  information for the recipient. With a 

custom report, the same “variables” can be assigned so PDFeXPLODE would be able to email it as well.   

 

Below is short explanation of the purpose of the “variables”, which are really Crystal Report formula fields that you assign, 

and how you can copy these formulas from one of the BOS standard reports into your own custom report.  

 

 
 

REAL/Easy has been programmed to assign these PDFeXPLODE Variables: 

 

Variable Content        Example 

------ -----------------------------------   ----------------------------- 

Var1 The command/report name    R713Invoice 

Var2 company name      Best Realty Company 

Var3 Var1 + YYYYMMDD    R713Invoice20090228 

Var4 Agent’s OfficeID + Var3    OFFICE2R173Invoice20090228 

 

These variables/formulas are placed in the “Page Header” section of the report. When the report is run,  each invoice or report 

page contains the emailing instructions needed by PDFeXPLODE.  The print line content to place in the report page header 

is: 

 

<pdfexplode>Var1,Var2,Var3,Var4 % recipientemailaddress </pdfexplode> 
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After installing version 14.12, the new emailable agent billing invoice is installed in the PC/server’s ..\BOS folder. The 

invoice report name is “agentinvoiceus.rpt”.  If you load this report into Crystal Reports, you can “Copy” the formulas in the 

"Report Header" and the "Page Header a" and paste them into the same sections of your custom report.  

 

The report header has these formula fields: Var1, Var3, Var4, CalcEmail, and CalcEmailTag.   The “page header a” section 

has the formula “VarTag” that has the expression:  

 

'<pdfexplode>'+{@Var1}+','+{@CompanyName}+','+{@Var3}+','+{@Var4}+'%'+{@CalcEmailTag}+'</pdfexplode>' 

 

Notes:   

 

� The email formulas format the agent email addresses. This means that the Agents table must be one of the tables in your 

report and the report should start a new page for each agent.  

� You must reassign the Var1 formula to a short report name for your custom report.  

� You must add a formula field “CompanyName” and assign it to your company name.  

 

Call the REAL/Easy help line for assistance.  

 

For your information these are the Setups for Variables Screen as documented in the version 14.12 upgrade reference. 

 

File Names group: 

 Check “Use variable for exploded file name”. 

 Click “Leading” radio button choice.  

 For "Select the variable to use for file name", choose “Var4” from the list box. 

 

Sub Folder Names group: 

 Check box “Use variable to create a sub-folder”   -- this will create a separate subfolder for invoices and each report type 

 For "Select the variable for sub-folder name", choose “Var1” from the list box.  

 

Email Merge group:  

 Check box the “Use variables in e-mail” option. 
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Mail Settings – Setup How Emails appear to the Agent Recipients 
    

 
This setup step defines how the emails with the pdf attached invoices and reports will appear to the agent recipients.  Move to 

the PDFeXPLODE option “Mail Settings” as shown above.  Complete "Default Mail and Connection Settings" as well as the 

"Exploded file path". 

 

Default Mail group:  

 Subject: enter the text as shown above. A number of “variables” and labeled “<Var1>”, etc, are assigned by REAL/Easy 

when the invoices/reports are processed and passed into the email subject and body.  

 Message Text: Enter the text as shown or similar to above referencing the two variables.    

 

Connection Settings group: 

 Sender Name:  enter the email address to be used as the reply address to all emails 

 Outgoing Mail SMTP server: enter the smtp server address for your provider 

 Sign on Username: enter the user name for access to your smtp account 

 Sign on Password: enter the password for access to your smtp account 

 Authentication Type: select from Login, POP, Plain, or None 

 Port: enter the port ID, usually 25 

 Incoming Mail Server: enter incoming mail server path 

 

Click “Test Connection” to verify the settings.  

 

 Exploded File Name: leave this blank, REAL/Easy will provide the name based on the invoice/report being processed.  

 Exploded File Path: enter a path where all pdf’s are to be placed. Note, REAL/Easy will create a sub folder based on the 

invoice/report being processed.  

 

Click “Save”  
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When an email is sent to a sales associate with an invoice or report, the subject and body text will appear as shown below: 

 

 

 
The subject will include the content name and date sent to help the sales agent save and organize the emails. Further, the pdf 

attachment name includes the content and date also helping if they are to be saved in folders for later retrieval.  

 

Note that the attachment names also include the agent’s office ID. This is included to help the company organize the emailed 

attachments on its end as they are saved on the company computer as well.  

 

To view the attached invoice or report, the agent/operator would click on the attachment name to initiate their Adobe pdf 

viewer as shown below: 

 

 
Click “Open with” and “OK”.  Note the agent/operator should also save to disk for later retrieval.  
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Above: an example of an invoice that was emailed to the agent as a pdf file. 
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NOTES: 
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